DEM Extraction Module
User’s Guide
Restricted Rights Notice
The IDL®, IDL Advanced Math and Stats™, ENVI®, ENVI Zoom™, and ENVI® EX software programs and the accompanying procedures, functions, and
documentation described herein are sold under license agreement. Their use, duplication, and disclosure are subject to the restrictions stated in the license
agreement. ITT Visual Information Solutions reserves the right to make changes to this document at any time and without notice.

Limitation of Warranty
ITT Visual Information Solutions makes no warranties, either express or implied, as to any matter not expressly set forth in the license agreement, including
without limitation the condition of the software, merchantability, or fitness for any particular purpose.
ITT Visual Information Solutions shall not be liable for any direct, consequential, or other damages suffered by the Licensee or any others resulting from use
of the software packages or their documentation.

Permission to Reproduce this Manual
If you are a licensed user of these products, ITT Visual Information Solutions grants you a limited, nontransferable license to reproduce this particular
document provided such copies are for your use only and are not sold or distributed to third parties. All such copies must contain the title page and this notice
page in their entirety.

Export Control Information
This software and associated documentation are subject to U.S. export controls including the United States Export Administration Regulations. The recipient
is responsible for ensuring compliance with all applicable U.S. export control laws and regulations. These laws include restrictions on destinations, end users,
and end use.

Acknowledgments
ENVI® and IDL® are registered trademarks of ITT Corporation, registered in the United States Patent and Trademark Office. ION™, ION Script™, ION Java™, and ENVI
Zoom™ are trademarks of ITT Visual Information Solutions.
ESRI®, ArcGIS®, ArcView®, and ArcInfo® are registered trademarks of ESRI.
Portions of this work are Copyright © 2009 ESRI. All rights reserved.
PowerPoint® and Windows® are registered trademarks of Microsoft Corporation in the United States and/or other countries.
Macintosh® is a registered trademark of Apple Inc., registered in the U.S. and other countries.
UNIX® is a registered trademark of The Open Group.
Adobe Illustrator® and Adobe PDF® Print Engine are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Numerical Recipes™ is a trademark of Numerical Recipes Software. Numerical Recipes routines are used by permission.
GRG™ is a trademark of Windward Technologies, Inc. The GRG software for nonlinear optimization is used by permission.
NCSA Hierarchical Data Format (HDF) Software Library and Utilities. Copyright © 1988-2001, The Board of Trustees of the University of Illinois. All rights reserved.
NCSA HDF5 (Hierarchical Data Format 5) Software Library and Utilities. Copyright © 1998-2002, by the Board of Trustees of the University of Illinois. All rights reserved.
CDF Library. Copyright © 2002, National Space Science Data Center, NASA/Goddard Space Flight Center.
SMACC. Copyright © 2000-2004, Spectral Sciences, Inc. and ITT Visual Information Solutions. All rights reserved.
This software is based in part on the work of the Independent JPEG Group.
Portions of this software are copyrighted by DataDirect Technologies, © 1991-2003.
Portions of this computer program are copyright © 1995-2008 Celartem, Inc., doing business as LizardTech. All rights reserved. MrSID is protected by U.S. Patent No. 5,710,835.
Foreign Patents Pending.
Portions of this software were developed using Unisearch’s Kakadu software, for which ITT has a commercial license. Kakadu Software. Copyright © 2001. The University of New
South Wales, UNSW, Sydney NSW 2052, Australia, and Unisearch Ltd., Australia.
This product includes software developed by the Apache Software Foundation (www.apache.org/).
Portions of this software are copyrighted by Merge Technologies Incorporated.
Support Vector Machine (SVM) is based on the LIBSVM library written by Chih-Chung Chang and Chih-Jen Lin (www.csie.ntu.edu.tw/~cjlin/libsvm), adapted by ITT Visual
Information Solutions for remote sensing image supervised classification purposes.
IDL Wavelet Toolkit Copyright © 2002, Christopher Torrence.
IMSL is a trademark of Visual Numerics, Inc. Copyright © 1970-2006 by Visual Numerics, Inc. All Rights Reserved.
Other trademarks and registered trademarks are the property of the respective trademark holders.
Contents

Chapter 1
Introduction to the DEM Extraction Module .......................................................... 5
Licensing the ENVI DEM Extraction Module ........................................................... 6
  Contacting ITT Visual Information Solutions ....................................................... 6
Introduction to DEM Extraction ............................................................................... 7
  Creating a DEM .................................................................................................... 8
  Output DEM Types ............................................................................................... 8

Chapter 2
DEM Extraction Wizard ......................................................................................... 9
The DEM Extraction Wizard .................................................................................... 10
Starting the DEM Extraction Wizard ...................................................................... 12
  Opening and Displaying the Input Data .............................................................. 12
The DEM Extraction Wizard GUI .......................................................................... 13
Step 1: Selecting the Stereo Image Pair ............................................................... 14
Step 2: Selecting Ground Control Points .............................................................. 16
Step 3: Viewing, Adding, Editing GCPs ............................................................... 18
  Adding Known GCP Locations ........................................................................... 19
  Using the Left/Right Stereo Image Coordinates ............................................... 20
  Controls for Viewing and Editing the GCPs ...................................................... 20
  Using Automatic Prediction ...
Chapter 1:
Introduction to the DEM Extraction Module

This chapter describes how to install the DEM Extraction Module and introduces the basic concepts behind DEM extraction. The following topics are covered:

Licensing the ENVI DEM Extraction Module . . 6     Introduction to DEM Extraction .............. 7
Licensing the ENVI DEM Extraction Module

The DEM Extraction Module is automatically installed when you install ENVI. However, to use the DEM Extraction Module, your ENVI license must include a feature that allows access to this module. If you do not have an ENVI license that includes this feature, contact ITT Visual Information Solutions or your ENVI distributor to purchase a new license key to access the DEM Extraction Module.

For information about entering a new ENVI license, refer to the *Installation and Licensing Guide*.

Contacting ITT Visual Information Solutions

If you encounter problems with the installation or licensing of this software product, contact Technical Support for assistance:

- E-mail: support@ittvis.com
- Phone: 303-413-3920
- Fax: 303-786-9909

International customers should contact their local ITT Visual Information Solutions office or distributor for technical support.
Introduction to DEM Extraction

A digital elevation model (DEM) is a regularly spaced raster grid of elevation values of a surface terrain. DEMs can be used to produce maps such as contour maps, orthophoto maps, and perspective maps. DEMs can also be used for route planning in the construction of highways and railways. In remote sensing, DEMs are used in mapping, orthorectification, and land classification.

The DEM Extraction Module enables you to extract elevation data from scanned or digital aerial photographs, or from an along track or an across track pushbroom satellite acquisition, such as those from the ALOS PRISM, ASTER, CARTOSAT-1, FORMOSAT-2, GeoEye-1, IKONOS, KOMPSAT-2, OrbView-3, QuickBird, RapidEye, WorldView-1, or SPOT satellites. Along track stereo images are acquired on the same orbital pass by a satellite which usually has more than one sensor looking at the Earth from different angles. Across track stereo images are those taken by the same sensor on multiple orbits.

The DEM extraction process requires a stereo pair of images containing rational polynomial coefficients (RPC) positioning from aerial photography or pushbroom sensors. RPCs are used to generate tie points and to calculate the stereo image pair relationship. See Building RPCs in the ENVI User’s Guide for details. DEM extraction does not currently support replacement sensor model (RSM) positioning.

The DEM Extraction Module is comprised of DEM Extraction Wizard and three DEM tools: DEM Editing Tool, Stereo Pair 3D Measurement Tool, and Epipolar 3D Cursor Tool.

DEM extraction is a multi-step, decision-making process that involves setting numerous parameters. You can run the steps individually from the ENVI main menu bar, or from within the DEM Extraction Wizard. The Wizard guides you through nine steps. It presents you with objective parameters, such as minimum/maximum elevation of the area of interest, as well as other strategy parameters that depend upon the terrain relief, cultural content, image quality, shadowing, and the desired speed of operation.

As with the DEM Extraction Wizard, you can extract a relative or absolute DEM from a stereo pair of images using the Stereo Pair 3D Measurement Tool and Epipolar 3D Cursor Tool.

- The **Stereo Pair 3D Measurement Tool** allows you to select a common point from two stereo images and calculate an elevation value for that point (see “Stereo Pair 3D Measurement Tool” on page 45 for detailed information about this tool).

- The **Epipolar 3D Cursor** tool allows you to perform 3D measurements in a 3D stereo viewing environment based on an existing epipolar stereo pair of images. You can view an anaglyph of epipolar stereo imagery and adjust the apparent height of the cursor to extract elevation data (see “Epipolar 3D Cursor Tool” on page 49 for detailed information about this tool).
Creating a DEM

There are three steps in creating a DEM that are crucial to generating acceptable results: epipolar image creation, image matching, and DEM geocoding.

- **Epipolar Image Creation**: Creating epipolar images is an essential processing step in DEM extraction. Epipolar geometry describes the geometrical constraint between two frame images of a stereo pair. It represents the fact that a ground point and the two optical centers lie on the same plane. This means that for a given point in one image, its conjugate point in the other image must lie on a known line in the second image. By creating epipolar images, the search space for finding corresponding image points in automatic image matching is reduced. For information about building epipolar images for the use with DEM Extraction Wizard, see “Building Epipolar Images” on page 61.

- **Image Matching**: Image matching finds the conjugate points on both the left and right images which correspond to the same ground feature. The output of the image matching procedure is called a parallax image, in which the x-coordinate difference (along epipolar lines) between the left and right image is stored and is used to build the DEM. Thus, the quality of image matching largely determines the quality of the output DEM.

- **DEM Geocoding**: DEM geocoding reprojects the DEM from the epipolar projection to an output map projection and units that you specify. This step involves filling failed pixels and resampling to a pixel spacing that you specify. When you provide ground control points (GCPs), you can compute the absolute orientation of the computed terrain model in this step.

**Output DEM Types**

An output DEM can either be relative or absolute, depending on the imagery and its associated information.

- **A relative DEM** is one with possible differences in position, scale, and rotation from the geodetic coordinates on the ground (horizontal reference system) and the mean sea level (vertical reference system). If the satellite imagery or aerial photography does not have GCP information associated with it, the DEM Extraction Wizard can derive a relative DEM result.

- **An absolute DEM** is one that is generated with GCPs. The DEM result is absolute in the sense that the horizontal and vertical reference systems are tied to geodetic coordinates. The DEM Extraction Wizard enables you to obtain either a relative DEM or an absolute DEM. Once you have extracted a DEM, you can edit the results to remove any processing artifacts.
Chapter 2

DEM Extraction Wizard

This chapter contains a step-by-step description of the DEM Extraction Wizard. The following topics are covered:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The DEM Extraction Wizard</td>
<td>10</td>
</tr>
<tr>
<td>Starting the DEM Extraction Wizard</td>
<td>12</td>
</tr>
<tr>
<td>Step 1: Selecting the Stereo Image Pair</td>
<td>14</td>
</tr>
<tr>
<td>Step 2: Selecting Ground Control Points</td>
<td>16</td>
</tr>
<tr>
<td>Step 3: Viewing, Adding, Editing GCPs</td>
<td>18</td>
</tr>
<tr>
<td>Step 4: Collecting Tie Points</td>
<td>22</td>
</tr>
<tr>
<td>Step 5: Viewing, Adding, Editing Tie Points</td>
<td>26</td>
</tr>
<tr>
<td>Step 6: Generating Epipolar Images</td>
<td>32</td>
</tr>
<tr>
<td>Step 7: Setting Output DEM Projection</td>
<td>34</td>
</tr>
<tr>
<td>Step 8: Selecting DEM Extraction Parameters</td>
<td>36</td>
</tr>
<tr>
<td>Step 9: Examining the DEM Result</td>
<td>39</td>
</tr>
</tbody>
</table>
The DEM Extraction Wizard

The DEM Extraction Wizard walks you through nine steps to extract a DEM. The Wizard allows you to step forward and backward, and to save the workflow at any step so that you can continue at a later time. The functionality provided in the nine steps is also available to run separately from the Wizard using the Topographic menu on the ENVI main menu bar. The Wizard workflow is illustrated in Figure 2-1, and the nine steps are outlined here.

1. **Step 1: Selecting the Stereo Image Pair**: Select the stereo pair, and supply the minimum and maximum elevation of the region.

2. **Step 2: Selecting Ground Control Points**: (Optional) Select the source for the ground control point (GCP) data.

3. **Step 3: Viewing, Adding, Editing GCPs**: Edit, add, and view GCPs. You can choose to read in a GCP file and edit it, or manually enter the GCPs in Step 2.

4. **Step 4: Collecting Tie Points**: Select the source of the tie points required for DEM extraction. You can have the Wizard automatically generate them, you can load an existing tie points file, or you can choose to enter the tie points yourself.

5. **Step 5: Viewing, Adding, Editing Tie Points**: Edit, add, and view tie points.

6. **Step 6: Generating Epipolar Images**: Create and save the left and right epipolar images.

7. **Step 7: Setting Output DEM Projection**: Set the projection system, the output DEM pixel size, and the number of rows and columns in the output.

8. **Step 8: Selecting DEM Extraction Parameters**: Define minimum correlation, moving window size and terrain detail, and specify where to save your DEM result.

9. **Step 9: Examining the DEM Result**: Display your DEM result. You may want to use the DEM Editing Tool to edit the displayed result.

These workflow steps are described in more detail in the following sections.
Figure 2-1: DEM Extraction Wizard Workflow Diagram
Starting the DEM Extraction Wizard

Before starting the DEM Extraction Wizard, ensure that ENVI is properly installed and licensed as described in the *Installation and Licensing Guide*. You must also have a license for the DEM Extraction Module.

Opening and Displaying the Input Data

The DEM Extraction Wizard requires a stereo pair of images containing rational polynomial coefficient (RPC) information from an along track or across track satellite acquisition, or from scanned or digital aerial photography. (See *Building RPCs* in the *ENVI User’s Guide* for details.) Along track stereo images are acquired on the same orbital pass by a satellite which usually has more than one sensor looking at the Earth from different angles. Across track stereo images are those taken by the same sensor on multiple orbits. Open these files before starting the Wizard.

1. From the ENVI main menu bar, select `File → Open External File → SPOT`, or `IKONOS`, or `QuickBird`, or `WorldView`, or `OrbView-3`, or `GeoEye-1`, or `ALOS/PRISM`, or `CARTOSAT-1`, or `FORMOSAT-2`, or `KOMPSAT-2`, or `RapidEye`.

   Or, select `File → Open Image File` to open a left and right image of a stereo pair from scanned or digital aerial photography.

   For ASTER Level 1A data, both the left and right images (bands 3N and 3B) are contained within one file. Select `File → Open External File → EOS → ASTER` from the ENVI main menu bar to open an ASTER data file.

2. From the ENVI main menu bar, select `Topographic → DEM Extraction → DEM Extraction Wizard → New`. Step 1 of the DEM Extraction Wizard opens.

   **Note**

   If `New` (the choice for a new DEM Extraction Wizard session) is disabled, you do not have the license needed to run the DEM Extraction Wizard in your installation. Contact your ENVI sales representative to obtain a license.
The DEM Extraction Wizard GUI

The DEM Extraction Wizard dialogs have five control buttons at the bottom: **Cancel**, **Help**, **Save**, **Prev**, and **Next**. The **Prev** and **Next** buttons allow you to maneuver backward and forward, respectively, through the nine steps of the Wizard.

- **Cancel** exits the Wizard at any time. A dialog prompts you to save the session before the session exits.
- **Help** initiates ENVI Help, which opens directly to information describing the current DEM Extraction Wizard step.
- **Save** can be used at any time while running the Wizard to save the settings and steps that have been completed. After saving your session steps, you can exit the Wizard or even the ENVI session.

You can resume your Wizard session from the step where the session was saved by selecting **Topographic → DEM Extraction → DEM Extraction Wizard → Use Previous File** from the ENVI main menu bar. Select your saved file, click **Open**, and the Wizard opens where you left off previously.

- **Next** continues to the next step in the Wizard, but it is only enabled when the required information has been provided in the current step.
- **Prev** maintains a list of the steps that have been performed. If you decide to change a parameter from a previous step, such as editing a tie point, you can use the **Prev** button to retrace your steps and make adjustments.
Step 1: Selecting the Stereo Image Pair

When you select Topographic → DEM Extraction → DEM Extraction Wizard → New from the ENVI main menu bar, the DEM Extraction Wizard opens with Step 1 of 9 (Figure 2-2). Here, you can select your left and right RPC positioned stereo imagery, and you can edit the scene’s minimum and maximum values.

1. Click Select Stereo Images to pick the left and right images for DEM extraction. ENVI computes RPCs and populates the Scene Elevation in Meters values.

   For ASTER data, select Band 3N as the left image and Band 3B as the right image. Also refer to Retaining RPC Information from ASTER, SPOT, and FORMOSAT-2 Data in the ENVI User’s Guide.

   **Note**

   If a data file contains an image obtained from a nadir-viewing direction while the other image is obtained from an off-nadir viewing angle, it is recommended that you
use the nadir-viewing image as the left image. The basis of this recommendation is that the left image is used as the base image during image matching, and it contains less geometric distortion.

Also, the base-to-height (B/H) ratio of the two images should be close to 1, but not 0. This ensures the viewing angles provide enough parallax information for ENVI to effectively compute elevations.

2. The **Minimum** and **Maximum Elevation** values (in meters) are automatically set from the RPCs; however, you can refine these values if you have a better estimate. Values are required in these fields to continue.

3. Click **Next** to continue.
Step 2: Selecting Ground Control Points

After you click Next in Step 1, the DEM Extraction Wizard: Step 2 of 9 dialog (Figure 2-3) appears. In this step, you select the source of your stereo GCPs. This is an optional step, since the default selection is No GCPs (relative DEM values only). You can either accept the default and click Next to move on to Step 4 of the Wizard, or you can select one of two other choices as the source of your GCPs.

1. Choose the source of the stereo GCPs by selecting one of the following choices (for information on relative and absolute DEMs, see “Output DEM Types” on page 8):
   - **No GCPs (relative DEM values only)**: This is the default selection. You can elect to not use GCPs, in which case Step 3 of 9 (GCP Collection) is skipped. Choosing this option would result in a relative DEM.
   - **Define GCPs Interactively**: This option requires that you manually enter, load, and edit GCPs that will tie the DEM to a planar map projection, therefore resulting in an absolute DEM.
   - **Read GCPs From File**: This option requires that you select a GCP file from which to read GCPs. You must provide a filename in the User Defined GCP File field.
2. To load a pre-existing GCP file, click **Select New GCP File**. The Select Input GCP File dialog appears. Navigate to your GCP file and click **Open** to load it into the Wizard.

3. The **Examine and Edit Stereo GCPs** option is only available if you have loaded a GCP file into the Wizard. Selecting **No** (default) results in skipping Step 3 of 9 (GCP Collection).

   **Note**
   If you are reading GCPs from a file, you should click the Examine and Edit Stereo GCPs toggle button to select **Yes**, so you may view and edit the GCPs.

4. Click **Next** to continue.
Step 3: Viewing, Adding, Editing GCPs

If you chose Define GCPs Interactively or loaded a GCP file to edit in Step 2 of the DEM Extraction Wizard, the stereo image pairs are loaded into two display groups and Step 3 of 9 appears (Figure 2-4), allowing you to collect GCPs interactively.

You can edit and add new GCPs in any of several different ways:

- Type the **Left/Right Stereo Image Coordinate** in the fields provided (see “Using the Left/Right Stereo Image Coordinates” on page 20).

- Enter **Map (x, y, z) Coordinate** values in the fields provided (see “Adding Known GCP Locations” on page 19).

- Use the button controls in the View and Edit Stereo GCPs (see “Controls for Viewing and Editing the GCPs” on page 20) to view and adjust the GCP locations in the images.

Whenever you make a change to an existing point that you want to keep, you must click the Update button in either the View and Edit Stereo GCPs section of the Wizard, or in the Stereo GCP Table. This updates the map coordinates and location information for that GCP.
If you decide that the current GCP is not what you want, click **Delete** to erase the current GCP.

If you make changes to a GCP but then decide you do not want to keep the changes, click **Reset** to return the GCP to its location prior to the editing changes.

**Adding Known GCP Locations**

If you have GCP map (x, y, z) coordinates, use this procedure to enter the data.

1. Click **Change Proj** to assign the projection to the map projection of your GCPs.
2. Enter the **Map (x, y, z) Coordinate** values to specify the map location and the **Elevation** of the known GCP position.
3. Click **Predict Left/Right** to have the **Left/Right Stereo Image Coordinate** predicted from the chosen map location and the RPCs of the images.
4. Fine-tune the GCP location in both images by using the Zoom window for each image.
5. Click **Add** to add the new GCP to your list of GCPs.
6. Continue to add points until you have entered all your GCPs.
7. If you have a GCP that needs some adjustment, make the adjustment in the Image or Zoom windows, and click **Update** to update the GCP settings.

**Using the Map (x, y, z) Coordinate**

1. You can also enter the **Map (x, y, z) Coordinate** values to specify a map location for a known GCP. The Projection Selection dialog appears, allowing you to change the projection and/or change the projection units.
2. You can change the Easting and Northing fields to Latitude and Longitude map coordinates for the current GCP by clicking the toggle button next to the map projection.
3. Enter the elevation in meters in the **Elevation (Meters)** field for the point described by the **E, N** (or **Lat/Long**) values.
4. Click **Add** to add the new GCP to your list of GCPs.

**Note**

While ENVI accepts one to any number of GCPs, it is desirable to have four or more GCPs evenly distributed around the images.

**Note**

Information must appear in the **Map (x, y, z) Coordinate** section in order to use the **View and Edit Stereo GCPs** functionality.
Using the Left/Right Stereo Image Coordinates

The Left/Right Stereo Image Coordinates fields show the currently selected pixels in the left and right images.

1. You can type known values into the **Left X**, **Left Y**, **Right X**, and **Right Y** fields and click **Enter** to move the Zoom box to the coordinates on the images.

2. Enter or modify the **Map (x, y, z) Coordinate** values of the GCP.

   Optionally, before you enter the **Map (x, y, z) Coordinate**, you can click **Predict Map** to have the **Map (x, y, z) Coordinate** predicted from the Left X, Y, Right X, Y location and the RPCs of the images. By comparing the predicted map coordinates with the true map coordinates of the GCP, you may be able to determine whether the GCP is valid or not.

3. Click **Add** to add the new GCP to your list of GCPs.

4. Continue to add points until you have entered all the GCPs.

5. If you have a GCP that needs some adjustment, make the adjustment in the Image or Zoom window, and click **Update** to update the GCP settings.

Controls for Viewing and Editing the GCPs

The **View and Edit Stereo GCPs** section contains the controls for interactively viewing, adding, and editing the GCPs. Here is a brief description of the controls found in the **View and Edit Stereo GCPs** section of Step 3 in the DEM Extraction Wizard.

**Note**
These controls are also available in the “Stereo GCP List Table” on page 21.

- Use the left arrow (←) and right arrow (→) buttons next to the **Current Stereo GCP**: field to navigate through existing GCPs. When you click either of the arrow buttons, the selected GCP is shown in each of the two images.

- **Go to**: If you have moved the Zoom box away from the current GCP in an image and you want to go back to the GCP, click the **Go to** button. Clicking **Go to** sends the Zoom box in both images to the current GCP.

- **Add**: When you are satisfied with the placement of a new GCP in the images, click **Add** to add the current image point as a new GCP.

- **Update**: Click this button to update the **Map (x, y, z) Coordinate**, and the Left/Right Stereo Image Coordinates of the **Current Stereo GCP** after you have repositioned the GCP.

- **Reset**: Click this button to reset the **Current Stereo GCP** to its original location. This action undoes all edits to the current GCP location.

- **Delete**: Click this button to delete the **Current Stereo GCP**.

- **Delete All**: Click this button to delete all of the existing GCPs.
• **Show Table**: Click this button to open the Stereo GCP List table. The table lists the Left and Right X, Y coordinates, Map (x, y, z) coordinates and the Map (x, y, z) errors for all of the GCPs currently entered for the stereo image pair.

The **Show Table** button changes to **Hide Table**, if the table is open.

• **Save**: Click this button to open the Save Stereo GCPs to ASCII dialog. Use this dialog to specify the path and filename in which to save your GCPs.

• **Restore**: Click this button to restore the Select Stereo GCPs Filename dialog, which allows you to load a stored GCP file.

**Using Automatic Prediction**

The **Auto Predict** buttons predict the Map (x, y, z) Coordinate from either a chosen point on the images or by entering values for the Left/Right Stereo Image Coordinate. You can also automatically predict the Left/Right Stereo Image Coordinate from given map coordinates.

**Stereo GCP List Table**

The Stereo GCP List contains the Left/Right Stereo Image Coordinate data, the Map (x, y, z) Coordinate data, and the error in the x, y, z directions for the GCPs.

The table also contains the same buttons found in the View and Edit Stereo GCPs section of the Wizard. When you click on a GCP number in the table, the left and right images are updated with the red Zoom box centered on the selected GCP. For detailed information about the controls in the Stereo GCP List Table, see “Controls for Viewing and Editing the GCPs” on page 20. After you choose GCPs and complete editing, click Next to continue.
Step 4: Collecting Tie Points

Next, define the relationship between the stereo images by selecting or generating tie points. The tie points are used to define the epipolar geometry and to create epipolar images, which are used to extract the DEM.

Define tie points using one of the following methods:

- **Generating Tie Points Automatically.** ENVI can generate tie points automatically, based on terrain features within the image.

- **Defining Tie Points Interactively.** Choosing this option requires that you manually define tie points between the two stereo images.

- **Reading Tie Points From File.** Choosing this option requires that you select a tie point file from which to read the tie points.
Generating Tie Points Automatically

Automatic tie point generation requires four parameters to be specified in Step 4 of the DEM Extraction Wizard:

- **Number of Tie Points**: Specify the number of tie points to generate. This can be as few as 9, but the recommended value is 25 (default setting).

- **Search Window Size**: Specify the search window size, in square pixels. The search window is a defined subset of the image, within which the smaller moving window scans to find a topographic feature match for a tie point placement. The search window size can be any integer greater than or equal to 21, but it must be larger than the Moving Window Size. The default is 81. This value depends upon the quality of the initial user-defined tie points (a minimum of three points) or the correctness of map, RPC, RSM, or pseudo map information for the base and warp image, and it also depends on the roughness of terrain.

If both images have certain map information, then a good way to establish the minimum search window size is to geographically link the base and warp images. Click a feature point (point A) in the base image, then click a feature point in the warp image. The cursor automatically moves to a point (point B) that is close to the ground feature point (point C) that represents the same ground feature as point A. Measure (in pixels) the distance between point B and point C in the warp image and use \(2 \times (\text{distance} + 1)\) as the minimum search window size. The search window size may vary considerably with different images. For example, 81 may be sufficient for one image pair, while 781 may be necessary for another image pair. Using a larger value results in a greater chance of finding the conjugate point, but takes longer processing time. Setting an excessively large value may result in false matches because more similar points may exist in a larger area.

- **Moving Window Size**: Specify the moving window size, in square pixels. The moving window scans methodically in the image subset area defined by the Search Window Size, looking for matches to a topographic feature. The moving window size must be an odd integer. The smallest allowable value is 5. The default is 11. Using a larger value results in a more reliable tie point placement, but takes longer processing time; conversely, a smaller value takes less processing time, but the tie points are less reliable. Determining a good moving window size largely depends upon the image resolution and terrain type. Some general guidelines follow:
  - For a 10 meters or higher resolution image, use a range of 9–15.
  - For a 5–10 meter resolution image, use a range of 11–21.
  - For a 1–5 meter resolution image, use a range of 15–41.
  - For a 1 meter or less resolution image, use a range of 21–81 or higher.
  - Because most buildings in very high-resolution images in an urban area appear similar, specify a larger value to take the surrounding area into account for more robust matching results. To reduce the computational time for image matching, ENVI automatically uses a hierarchical matching method when the moving window size is greater than or equal to 19.

- **Region Elevation**: The value shown in this field is an average elevation based on the dominant elevation of the image. It is estimated based on the associated RPC
information. You may need to adjust this value based on your own knowledge of the dominant elevation of your image.

**Note**

Increasing the **Number of Tie Points**, the **Search Window Size**, and/or the **Moving Window Size** increases the processing time but should also increase the reliability of the matching.

- **Examine and Edit Tie Points**: This option is available when generating tie points automatically. This option is set to **Yes** by default. It is recommended that you accept the **Yes** default setting so that you can review the tie points and edit those that are less than optimal. Selecting **No** results in the Wizard applying the tie points, skipping Step 5, and proceeding to Step 6 of 9 (see “Step 6: Generating Epipolar Images” on page 32).

  Click **Next** to continue.

**Note**

If the y-parallax error of any of the tie points exceeds 10 pixels, an ENVI Error dialog appears with the maximum y-parallax value. You should use the **Prev** button in Step 6 of the Wizard to return to Step 5 (see “Step 5: Viewing, Adding, Editing Tie Points” on page 26), and make sure all of the tie points are correct before proceeding.
Defining Tie Points Interactively

Use this option to input your tie points by selecting them in one or both images. You must enter a minimum of 9 tie points in the images; however, 25 tie points is recommended.

Click Next to begin entering the tie points in Step 5 of 9.

Reading Tie Points From File

Choosing this option requires that you select a tie points file to use with the images file. When you select this option, you must provide a filename in the User Defined Tie Points File field.

1. Click the Select New Tie Points File button to bring up the Select Input Tie Points File dialog.

2. In the Select Input Tie Points File dialog, navigate to your tie points file and click Open. The path and filename appear in the User Defined Tie Points File text field.

3. Choose whether you want to edit the tie points from the file before continuing in the Wizard. The Examine and Edit Tie Points toggle button is set to No by default, but it is recommended that you examine the tie points before proceeding. To do this, switch the toggle to Yes, so that you can review the tie points and edit those which are less than optimal.

   If you do not want to examine the tie points, leave the toggle button set to No (the default setting). Selecting No results in the Wizard applying the tie points, skipping Step 5, and proceeding to Step 6 of 9 (see “Step 6: Generating Epipolar Images” on page 32) when you click Next.

4. Click Next to proceed.

   **Note**
   
   If the y-parallax error of any of the tie points exceeds 10 pixels, an ENVI Error dialog appears with the maximum y-parallax value. You should use the Prev button in Step 6 of the Wizard to return to Step 5 (see “Step 5: Viewing, Adding, Editing Tie Points” on page 26), and make sure all of the tie points are correct before proceeding.
Step 5: Viewing, Adding, Editing Tie Points

If you chose Generate Tie Points Automatically, or Define Tie Points Interactively, or if you loaded a tie point file to edit in Step 4, Step 5 of 9 (View and Edit Tie Points) appears (Figure 2-7).

You can edit and add new tie points interactively in the left and right images and by using the button controls in the View and Edit Tie Points section of the DEM Extraction Wizard. Select a location in one or both of the images and use the controls to add, update, or delete tie points in the tie point list.

Adding New Tie Point Locations

To define your tie points interactively, you must position the Zoom box in each image over the same point.

1. Move the Zoom box in both images to the same location.

   You can also select a point in one image and use the Auto Predict controls (Predict Left and Predict Right) to have the Wizard find the conjugate point in the other image.
2. Use the Zoom windows for the two images to fine-tune the tie point location in both images.

3. When the tie point location looks satisfactory, click Add to add the new tie point to the Stereo Tie Points List table.

Editing Tie Point Locations

The control buttons in Step 5 of the DEM Extraction Wizard allow you to maneuver from tie point to tie point, change the location of a point, update the list, and correct positional errors which may result from automated tie point generation.

1. Use the left arrow (←) and right arrow (→) buttons next to the Current Stereo GCP: field to navigate through existing tie points.

2. Examine the tie point location in both images looking for slight to obvious mismatch conditions. If the tie point in one or both of the images needs adjustment, use the Zoom window to fine-tune the tie point placement.

3. When you are satisfied with the adjustments, click Update to update the Left/Right Stereo Image Coordinate of the tie point.

Using the Auto Predict Features

The Auto Predict section contains three buttons (Predict Left, Predict Right, and Params) as well as the Region Elevation text field.

- **Predict Left**: When you select a new tie point in the right image, use Predict Left to predict the matching location in the left image. If the predicted location is not desirable, move the left tie point to the appropriate location and click Add to add the tie point as a new tie point, or click Update to have the Current Tie Point updated to the new location.

- **Predict Right**: Similarly, when you select a new tie point in the left image, use Predict Right to predict the matching location in the right image. If the predicted location is not desirable, move the right tie point to the appropriate location and click Add to add the tie point as a new tie point, or click Update to have the Current Tie Point updated to the new location.

- **Params**: When you select Params, the Predict Left/Right Parameters dialog opens (Figure 2-8). Use this dialog to adjust the Search Window Size and the Moving Window Size. If you increase the Search Window Size, this increases the chances that the automatic prediction can find the correct match; however, this increased search window requires more processing time to accomplish the auto predict task. If you increase the Moving Window Size, the auto prediction is more likely to find the correct match, but again, this requires more processing time to accomplish. Click OK to apply the changes and dismiss the dialog.
Region Elevation: The value shown in this field is an average elevation based on the dominant elevation of the image. Adjust this value for each auto prediction based on your knowledge of the elevation of the point of interest. This value is used to guide the auto prediction process, so you should adjust it for each tie point prediction, especially if the elevation varies widely over the whole image.

Viewing a Specific Tie Point

Use one of the following options to view a specific tie point:

- Click on a tie point number in the Likely Error Rankings list.
- Click on a tie point number in the Stereo Tie Points List table.
- Use the left arrow (←) and right arrow (→) buttons next to the Current Tie Point field to navigate through the tie points.

Editing Controls

There are several helpful controls in the editing section for making changes to the tie points:

- Go to: Moves the cursor to the Current Tie Point position in the images. If you move the Zoom box away from the current tie point, and you decide you want to go back to the tie point, click Go to.
- Add: Adds the current location in the left and right images as a new tie point.
- Update: Updates Current Tie Point with the current position. This updates the Left/Right Stereo Image Coordinates, the information in the Stereo Tie Points List table, the Likely Error Rankings, and the Maximum Y Parallax if there are at least nine tie points.
- Reset: Resets the Current Tie Point to the original location, undoing all edits. If you made changes to the current tie point that you want to undo, click Reset.
- Delete: Deletes the tie point shown as the Current Tie Point.
- Delete All: Deletes all existing tie points.
In addition, use the following controls to manage your editing session:

- **Save**: Opens the Save Stereo Tie Points to ASCII dialog. Use this dialog to specify the path and filename in which to save your tie points, or use the **Choose** button in the dialog to open the Output Filename dialog. Navigate to the folder or file in which to save the tie point information. Click **OK** to save the file.

- **Restore**: Opens the Select Stereo Tie Points Filename dialog which allows you to load a stored tie point file. If you do this after adding tie points, the restored file overwrites the existing tie points.

- **Show Table**: Opens the Stereo Tie Points List table (Figure 2-9). The table lists all of the tie points currently entered for the stereo image pair. Using the **Sort Table By** drop-down button in the table, you can sort the tie points by **Tie Point Number** (the default), or by **Error Rank**. The **Error Rank** numbers are a listing of the tie points from the tie point with the most error (Error Rank 1) to the least error.

The Stereo Tie Points List table contains the same edit control buttons described above. The **Show Table** button in the Wizard changes to **Hide Table**, when the table is open.

### Examining the Tie Points

It is recommended that you examine tie points that were read from a file or automatically generated to determine their accuracy. Step 5 of the Wizard contains several ways to determine the accuracy of the tie points: the **Maximum Y Parallax** (which is a calculated from the tie points), the **Likely Error Rankings** of all the tie points, and the Stereo Tie Points List table.

#### Using the Maximum Y Parallax Value

The **Maximum Y Parallax** value is only shown if there are more than nine tie points selected for the stereo pair. This number is the y-parallax value (in pixels) of all of the currently selected tie points in the output epipolar images, assuming that these points are used to compute the epipolar geometry of the stereo pair. The **Maximum Y Parallax** value is updated each time you edit and update one of the tie points.

The highest **Maximum Y Parallax** value allowed to continue with the next step of the Wizard is 10 pixels. Ideally, the y parallax value should be as close to zero as possible; however, a higher value such as 1 or 2 pixels may be acceptable.

If the value is close to 0 or 1, no further tie point adjustments are necessary. If it is much greater than 1 or 2, you should re-examine the tie points and correct those that are not good matches. When examining tie points for errors, you can use the tie points listed at the top of the **Likely Error Rankings** list or click the **Show Table** button to open the Stereo Tie Points List table (see “Using the Stereo Tie Points List Table” on page 30 for more information about how to use the table). Use the **Sort Table By** drop-down list to select **Error Rank** as the sorting criteria. Tie points that are at the top of the list are those with the highest error likelihood.

The **Maximum Y Parallax** value is the quickest way to check how good the tie point placement is in your images. If, for instance, the **Maximum Y Parallax** for the automatically generated tie points was 33.7894 pixels, that would be quite a bit larger than the maximum allowable value of 10. In this case, if you declined to edit the tie points in Step 4, an ENVI...
Error message appears telling you that the **Maximum Y Parallax** value of 33.79 (in this case) exceeds the limit of 10. Click **OK** in the ENVI Error message, then use the **Prev** button in the DEM Extraction Wizard Step 6 to back-track to Step 5, and make sure all the tie points are correct before proceeding. By editing the tie points, you should be able to reduce the y-parallax value close to 0.

### Using the Likely Error Rankings

The **Likely Error Rankings** drop-down list displays tie points in the order of the likelihood of error; the first tie point in the list is the one with the greatest likelihood of error, and the last tie point is the least likely erroneous tie point.

The list shows the tie points followed by a number in parentheses. The number in parentheses is a value between 0.000 and 1.000, indicating the relative likelihood of error for that tie point, where 0.000 is the least likely and values close to or equal to 1.000 are the most likely. If you click on a tie point in the list, the red Zoom box in the Image window goes to that tie point number in both the left and right images. This is an easy method for editing the tie points; however, it is possible that the tie points at the top of the **Likely Error Rankings** list have no discernible error upon inspection. If this is the case, it is not necessary to make any further adjustments to those points; instead, check other points even if the error likelihood is lower.

### Using the Stereo Tie Points List Table

The Stereo Tie Points List table contains the **Left/Right Stereo Image Coordinate** data and an error rank for the tie points. The **Error Rank** is from the most likely error to the least; so, Error Rank 1 is assigned to the tie point pair with the highest likelihood of being a bad match.

![Stereo Tie Points List](image)

**Figure 2-9: Stereo Tie Points List**

If the **Maximum Y Parallax** value shown in the **View and Edit Tie Points** section of step 5 is significantly bigger than 1, you should edit the tie points. You can click the **Sort Table By**
drop-down button and select **Error Rank** as the sorting criteria. Scroll to the top of the list to see which tie points should be adjusted first.

When you click on a tie point number in the list, the Zoom boxes in both Image windows are updated to show that tie point location. You can make adjustments to the tie point location if necessary, and click **Update** in either the table or the Wizard to save the new location for that tie point. Whenever you update a tie point, the **Error Rank** in the table changes, along with the **Maximum Y Parallax** value.

It is possible for the **Maximum Y Parallax** value to not change appreciably when you adjust the one or two tie points with the highest **Error Rank**; and sometimes when you look in the images at the tie points listed in the table as the most likely erroneous, they appear instead to be fairly good matches. If this happens, it is best to scroll through the tie points and visually inspect the quality of each match, adjusting those which are less than optimal.

**Note**

If the tie points listed at the top of the error rank seem to be very good matches, but the **Maximum Y Parallax** value is still larger than 1, you should use the options in the **View and Edit Tie Points** section of step 5 of the Wizard to scroll through all of the tie points to find which points to edit.

After you have viewed your tie points and performed any adjustments necessary to reduce the **Maximum Y Parallax** value as close to 0 as possible, click **Next** to proceed to Step 6 of the Wizard.
Step 6: Generating Epipolar Images

Using the tie points, ENVI will calculate the epipolar geometry and epipolar images that are used to extract the DEM. These epipolar images describe the relationship between the pixels in the stereo pair and they can be viewed in 3D using anaglyph glasses.

Epipolar images are stereo pairs in which the left and right images are oriented in such a way that ground feature points have the same \( y \)-coordinates on both images. Using epipolar images removes one dimension of variability, thus greatly increasing the speed of image-matching processing as well as the reliability of the matching results.

In Step 6 of 9 of the DEM Extraction Wizard, the left and right epipolar images are created and saved. You have the option of viewing these epipolar images at this time, or you can continue with the DEM extraction and examine the epipolar images at a later time. If you decide to view the epipolar images now using anaglyph glasses, you can use the Epipolar 3D Cursor Tool to collect map and elevation points. You can export these to an ASCII file, an EVF file, or an ArcView® 3D shapefile. See “Epipolar 3D Cursor Tool” on page 49 for more information about this DEM Extraction tool.

![Figure 2-10: Step 6 – Select Epipolar Parameters](image)
Note

If the y-parallax error of any of the tie points exceeds 10 pixels, an ENVI Error dialog appears with the maximum y-parallax value. You should use the **Prev** button in Step 6 of the Wizard to return to Step 5 (see “Step 5: Viewing, Adding, Editing Tie Points” on page 26), and make sure all of the tie points are correct before proceeding.

The **Epipolar Reduction Factor** controls the down-sampling of the output epipolar image size. This factor is a floating-point value with a minimum value of 1.00 (the default), which determines the lowest image pyramid level on which image matching can be performed. A value of 1.00 means the epipolar images have the same resolution as the input images. A value of 2.00 means the epipolar images have half the spatial resolution as the input images. In this case, the processing takes less time, requires less disk space, but limits the highest resolution of the DEM output.

The buttons in the **Examine Epipolar Results** section enable you to generate and examine the epipolar images immediately. Your choice for the left and right images when you started the Wizard determines whether the epipolar image viewed is the **true stereo** 3D epipolar image or the **inverse stereo** 3D epipolar image. You can view the resulting image and use the Epipolar 3D Cursor to adjust the apparent height of the cursor in order to extract elevation data. See “Epipolar 3D Cursor Tool” on page 49 for detailed information.

- Click **RGB=Left, Right, Right** to create an epipolar image pair and to load the stereo epipolar image pair in RBG color mode. In this case, the red channel is the left epipolar image, and the blue and green channels are the right epipolar image. When the RGB epipolar image is created this way, you can view the result in 3D using anaglyph glasses.
  
  If your image appears inverted (where high elevation features appear to go into the screen), the image is in the inverse stereo 3D epipolar view.

- Click **RGB=Right, Left, Left** to create an epipolar image pair and to load the stereo epipolar image pair in RBG color mode. In this case, the red channel is the right epipolar image, and the blue and green channels are the left epipolar image. When the RGB epipolar image is created this way, you can view the result in 3D using anaglyph glasses.

Click **Next** to continue.
Step 7: Setting Output DEM Projection

Step 7 of the DEM Extraction Wizard allows you to set parameters for the DEM output projection and map extents. You have the option to change parameters such as the output projection type, pixel size, or output image size.

![ DEM Extraction Wizard: Step 7 of 9 ]

The **Output Projection and Map Extent** shows the **Upper Left Corner Coordinate** map projection and Eastings and Northings of the upper-left corner of the output DEM projection. You may want to change the point defined as the **Upper Left Corner Coordinate** of your output projection, based on your own knowledge of the overlapping region in your output projection.

1. To change the **Upper Left Corner Coordinate**, type in the new map coordinates in the Eastings and Northings text fields, and press **Enter**.
2. You can change the Eastings and Northings fields to Latitude and Longitude map coordinates by clicking the toggle button next to the map projection.
3. To change the projection, click **Change Proj.** Select a new projection from the list in the Projection Selection dialog, click **Units**, change the units as desired, and click **OK.** The values of the map projection **X** and **Y Pixel Sizes** are changed to reflect the new units and projection.

4. The x and y post spacing (**X Pixel Size, Y Pixel Size**) for the output projection is dictated by the input projection chosen. You may want to adjust the values for the x and y post spacing, or you may want to change the units of these values.

   To change the **X Pixel Size**, enter a new value and press `<Enter>`. Repeat for the **Y Pixel Size**. When you change these values, the **Output X Size** and **Output Y Size** values also change.

5. The **Output X Size** and **Output Y Size** values describe the output DEM size in pixels. This is the overlapping region of your output projection. You may want the output projection size to be different from the output values shown. Change the **Output X Size** by typing a new value and pressing `<Enter>`. Repeat for **Output Y Size**.

   There are six options available from the **Options** drop-down list:

   - **Report output size in Pixels**: Sets the **Output X Size** and **Output Y Size** units in pixels (default).
   - **Report output size in Meters**: Sets the **Output X Size** and **Output Y Size** units in meters.
   - **Maintain map extent when pixel size changes**: Automatically adjusts the number of rows and columns (**Output X Size** and **Output Y Size**) to maintain the map extent (default).
   - **Maintain output pixels when pixel size changes**: Maintains the **Output X Size** and **Output Y Size**, even if the **X Pixel Size** or **Y Pixel Size** changes.
   - **Restore initial values**: Performs an undo of any changes made to the settings in this Wizard step. This resets the Step 7 settings to the default settings.
   - **Match existing file**: Allows you to use the map extent from an existing file.

6. Click **Next** to continue.
Step 8: Selecting DEM Extraction Parameters

Step 8 of the DEM Extraction Wizard allows you to specify the parameters for the DEM extraction. Here you can define thresholds, set the size of the area in which you wish to perform image matching, determine the level of terrain detail, and specify where to save your DEM result.

![Figure 2-12: Step 8 – Select DEM Extraction Parameters](image)

**Warning**

Temporary files are created during the DEM extraction processing that may be large, depending on the input image size, the Epipolar Reduction Factor, and the Terrain Detail setting. Be sure your temporary directory has enough available space to allow for these files.

This dialog has two sections: DEM Extraction Parameters, and DEM Result. You can change the Wizard settings or accept the defaults.

1. Set the Minimum Correlation value between 0.00 and 1.00. This is the correlation coefficient threshold used to determine whether or not two points are a good match. If a correlation coefficient is smaller than this minimum, then the two points are not
considered a good match. Using a smaller threshold value allows more matches, but it reduces the accuracy since some of the matches will be false match points. A higher threshold value increases the accuracy, but it will result in fewer matches. In general, values between 0.65 and 0.85 are reasonable. The default is 0.70.

2. Set the **Background Value** for the output DEM. You can choose any value that is beyond valid elevation values. The default background value is –999.00.

3. Set **Edge Trimming** to a floating-point value between 0.0 and 0.6, indicating the normalized percentage of trimming to apply to the outer edges of the output DEM. The diagram in Figure 2-13 illustrates **Edge Trimming** set to 0.1, where 10% of the outer borders of the DEM are trimmed, amounting to 5% of the outer edge being trimmed on each opposing side.

4. Set the **Moving Window Size** for the template window used to perform image matching. The **Moving Window Size** defines the area in which to compute the correlation coefficients between the two image templates. A larger **Moving Window Size** yields more reliable, yet less precise matching results, and it requires more processing time to complete. The default size is 5 x 5 square pixels.

   **Note**
   For images with a bigger **Moving Window Size**, such as 7 x 7 or 9 x 9, you should set the **Minimum Correlation** to a smaller value.

5. Select the type of terrain your DEM best represents from the **Terrain Relief** pull-down list.
   - **Low**: Select this option if the terrain consists primarily of flat areas and low-terrain relief. The DEM will have a smoothed effect.
   - **Moderate**: Default option, appropriate for most terrain types.
• **High:** Select this option if the terrain consists primarily of mountainous and high-terrain relief. Topographic features with large relief displacement are not smoothed.

6. Determine the level of **Terrain Detail.** DEM extraction uses image matching to find matching features on the left and right image of the stereo pair. The use of **Terrain Detail** determines how precisely you wish to represent the terrain in the DEM output by controlling the number of image pyramid levels used during the image matching. The levels range between 1 (minimum) and \( N \) (maximum), where \( N \) is determined by the epipolar image size. The Level 1 terrain detail indicates that image matching stops after the coarsest level of image matching is finished. Level \( N \) indicates that image matching is performed on the highest image resolution possible (the epipolar image resolution).

**Terrain Detail** is a major controlling factor that determines the processing time needed to extract a DEM, as well as the accuracy of the output DEM. The higher the level, the longer the necessary processing time and the more terrain detail is represented in the output DEM.

7. Set the **Output Data Type.** You can choose between **Integer** (default), which occupies two bytes; or **Floating Point**, which occupies four bytes.

8. Select whether to save the output to **File** (default) or **Memory.** If you select **File**, enter a filename or use the **Choose** button to navigate through the directory structure and select a filename.

9. **Click Next** to start the DEM extraction process.

The required processing time can be significant, depending on your choices for **Moving Window Size** and **Terrain Detail** level. As the processing completes, the various files created (Left Epipolar Image, Right Epipolar Image, and the Elevation result) appear in the Available Bands List.

Continue to Step 9.
Step 9: Examining the DEM Result

Once DEM extraction is complete, you can examine and/or edit the resulting DEM. The last screen of the Wizard provides two options. Both options load the DEM result to a display group, but one option also opens the DEM Editing Tool so you can edit the DEM.

- **Load DEM Result to Display** loads the processed DEM result into a display group.
- **Load DEM Result to Display with Editing Tool** loads the processed DEM result into a display group and opens the DEM Editing Tool dialog for editing the DEM. This is the recommended selection, since you can use the DEM Editing Tool to fix any bad DEM values in the output DEM. See “DEM Editing Tool” on page 41 for more information about this DEM Extraction tool.

After you have viewed and/or modified your DEM, click **Finish** to exit the DEM Extraction Wizard. This opens an ENVI prompt asking if you want to save the current state of the DEM Extraction Wizard to use at a later time.

- Select **Yes** to save the DEM Extraction Wizard to an ASCII .txt file.
- Select **No** to continue exiting the Wizard without saving.
- Click **Cancel** to return to Step 9 of 9 of the DEM Extraction Wizard.
Chapter 3

DEM Editing Tool

This chapter describes the DEM Editing Tool which can be used to edit DEMs as well as image bands. The following topics are covered:

---

The DEM Editing Tool .................. 42  Editing the DEM Band .................. 43
---
The DEM Editing Tool

When you click **Load DEM Result to Display with Band Edit** in the last step of the DEM Extraction Wizard, the DEM Editing Tool dialog displays and the DEM is loaded into a display group. The DEM Editing Tool enables you to interactively edit pixel values within a region of interest (ROI) using one of seven different methods.

**Note**
The edits you make using the DEM Editing Tool are applied immediately to the file. It is recommended that you save a copy of your file to either disk or memory and perform your edits on the copy. This way, the original data file remains intact for additional processing at a later date.

Post-processed DEMs often require editing to remove artifacts, such as setting bodies of water to a constant elevation. There are seven methods available (Table 3-1) for editing the values of selected posts once an ROI has been defined.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace with value</td>
<td>Replaces the ROI with an assigned value. The allowed values depend on the minimum and maximum for the input DEM. You must supply a <strong>Value</strong> input.</td>
</tr>
<tr>
<td>Replace with mean</td>
<td>The mean is calculated for selected posts, and all posts in the ROI are set to that mean value.</td>
</tr>
<tr>
<td>Smooth</td>
<td>Low-pass convolution is performed based on the specified kernel size. Larger kernel sizes result in more smoothing. Selected posts in the ROI are modified as a result of the smoothing. The default kernel size is 3.</td>
</tr>
<tr>
<td>Median Filter</td>
<td>Selected posts in the ROI are replaced with the median value from the neighborhood specified by the kernel size. The default kernel size is 3.</td>
</tr>
<tr>
<td>Noise Removal</td>
<td>If the ROI post value is greater than two standard deviations of the mean of the surrounding posts, it is replaced with the median of the surrounding posts.</td>
</tr>
<tr>
<td>Triangulate</td>
<td>Border posts surrounding the ROI are interpolated across the ROI using triangulation.</td>
</tr>
<tr>
<td>Thin Plate Spline</td>
<td>Border posts surrounding the ROI are interpolated across the ROI using a thin plate spline method.</td>
</tr>
</tbody>
</table>

*Table 3-1: DEM Editing Methods*
Editing the DEM Band

To edit a DEM, do the following:

1. Select which window to use to define the ROI: **Image** (default), **Scroll**, **Zoom**, or **Off**.
2. Select the type of ROI using the **Type** drop-down list: **Polygon** (default), **Rectangle**, or **Ellipse**.
3. Select a **Color** to use for highlighting the ROI. You can change the color by clicking on the color swatch with the left mouse button, or by right-clicking on the color swatch and choosing a color from the color lists. The default is red.
4. Select the editing **Method** to use from the drop-down list: **Replace with value** (default), **Replace with mean**, **Smooth**, **Median Filter**, **Noise Removal**, **Triangulate**, or **Thin Plate Spline**.
   - If you accept the default method **Replace with value**, select a **Value** to assign to the ROI. The allowed values are determined by the input DEM data type, maximum, and minimum. There is no default value.
   - If you select the **Smooth** method, choose a **Kernel Size** to use for the smoothing kernel. Larger values for the kernel size result in more smoothing. The default is 3.
   - If you select the **Median Filter** method, choose a **Kernel Size** to use for the Median Filter kernel. Pixels in the ROI are replaced with the median value from the neighborhood specified by the kernel size. The default is 3.
5. Click and drag the left mouse button to draw the ROI in the image. Click the right mouse button to commit the selected ROI, or click the **Apply to Region of Interest** button.
Note
When you commit the ROI by clicking the right mouse button, the pixels are automatically modified according to the selected method.

The Smooth method can be applied to an ROI or to the entire DEM. To apply Smooth to an ROI, either right-click on the ROI or click Apply to Region of Interest. To apply Smooth to the entire DEM, click Apply to Entire Band.

The Median Filter method can be applied to an ROI or to the entire DEM. To apply Median Filter to an ROI, either right-click on the ROI or click Apply to Region of Interest. To apply Median Filter to the entire DEM, click Apply to Entire Band.

6. To delete a selected ROI, click the middle mouse button.

Performing a DEM Edit Undo

A running tally of the edits made to the DEM is shown next to the Edits field in the dialog. All of the edits made can be undone until you click Save Changes. You can made additional edits after you save changes, and you can undo these changes until you save them.

- Use Undo Last Edit to undo the most recent change made to the DEM. You can repeatedly click this button to undo all of your changes, one by one.
- Use Undo All Edits to undo all edits made to the DEM since the last Save Changes.

Closing the DEM Editing Tool

Click the Cancel button to close the DEM Editing Tool dialog. If you have not saved your edits, a dialog will prompt you to do so. When you exit the DEM Editing Tool dialog, both the DEM Editing Tool dialog and the associated display group are closed.
This chapter describes how to extract elevation data from a stereo pair of images using the Stereo Pair 3D Measurement Tool. The following topics are covered:

- The Stereo Pair 3D Measurement Tool  . . . . . . . 46
- Collecting Elevation Points  . . . . . . . . . . . . . . . . 48
- Opening the Stereo Pair 3D Measurement Tool  46
The Stereo Pair 3D Measurement Tool

The Stereo Pair 3D Measurement Tool allows you to select a common point from two stereo images and to calculate an elevation value for that point. Points obtained in this way can be exported to an ASCII file, EVF file, or ArcView® 3D shapefile.

Note

The stereo image pair must either contain rational polynomial coefficient (RPC) data or the necessary metadata from which RPCs can be calculated. DEM extraction does not currently support replacement sensor model (RSM) positioning.

Opening the Stereo Pair 3D Measurement Tool

The Stereo Pair 3D Measurement Tool requires a stereo pair of images containing RPC positioning from an along track or across track satellite acquisition, or from scanned or digital aerial photography. Along track stereo images are acquired on the same orbital pass by a satellite. Across track stereo images are those taken by the same sensor on multiple orbits. Open these files before starting the tool.

1. From the ENVI main menu bar, select Topographic → DEM Extraction → Stereo 3D Measurement. The Select Left Stereo Pair Image dialog opens. See “Step 1: Selecting the Stereo Image Pair” on page 14 for instructions on opening the left and right image stereo pair.

2. When you click OK in the Select Right Stereo Pair Image dialog, the RPCs are computed, if necessary (which is the case for ASTER and SPOT imagery), and the left and right stereo images open in new display groups. The Stereo Pair 3D Measurement Tool dialog opens (Figure 4-1).
3. In either the left or right Image window, locate the Zoom box over a feature whose 3D measurement you want to collect. Click **Predict Right** or **Predict Left** to center the Zoom box in the second image on the conjugate point.

4. At this point, you can adjust the selected locations in the Zoom window if necessary, or if the auto predict functionality failed to find a conjugate point, you may need to adjust the Auto Prediction Parameters. Click **Params** to open the Predict Left/Right Parameters dialog.

The Predict Left/Right Parameters dialog has two settings used to define the search area: **Search Window Size** and **Moving Window Size**. See “Generating Tie Points Automatically” on page 23 for a description of these parameters. If the image is a high resolution image, increase the **Moving Window Size**.

5. Click **Get Map Location** to compute the Lat/Long and elevation based on the RPCs and selected points.

6. When you are satisfied with the matching points, click **Export Location** to enter the map and elevation information to an ENVI Point Collection dialog.

7. Click **Cancel** to close the Stereo Pair 3D Measurement dialog.
Collecting Elevation Points

When you have found a pair of matching locations using the Stereo Pair 3D Measurement Tool, you can collect the map and elevation information using **Export Location**. When you click **Export Location**, an ENVI Point Collection table opens (Figure 4-2).

For complete information about the ENVI Point Collection table, see **Collecting Points** in the *ENVI User’s Guide*.

![Figure 4-2: ENVI Point Collection Table](image)

Each time you find a matching pair of locations and export the values using **Export Location**, the point is added to the ENVI Point Collection table. The following options are available from the ENVI Point Collection table include:

- Left-click in the **Attribute Description** cell and type a description for the point. Do not use spaces in the description text. Left-click on the cell to accept the description text.
- To delete a point from the table, select the point number to highlight the row and click **Delete**.
- To clear all of the points, click **Delete All**.
- To save the points in an ASCII file, EVF file, or as points, polylines, or polygons in an ArcView® 3D shapefile, click **File → Save Points As → file format**.

**Note**

The **Goto** button is inactive for use in the Stereo Pair 3D Measurement Tool point collection.
Chapter 5

Epipolar 3D Cursor Tool

This chapter describes how make 3D measurements of elevation data in a 3D viewing environment using the Epipolar 3D Cursor Tool. The following topics are covered:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Epipolar 3D Cursor Tool</td>
<td>50</td>
</tr>
<tr>
<td>Collecting Elevation Points</td>
<td>53</td>
</tr>
<tr>
<td>Opening the Epipolar 3D Cursor</td>
<td>50</td>
</tr>
</tbody>
</table>
The Epipolar 3D Cursor Tool

The Epipolar 3D Cursor tool allows you to perform 3D measurements in a 3D stereo viewing environment based on an existing epipolar stereo pair of images. You can view an anaglyph of epipolar stereo imagery and adjust the apparent height of the cursor to extract elevation data. Elevation data obtained this way can be exported to an ASCII file, EVF file, or ArcView® 3D shapefile.

Note

The epipolar stereo image pair can be created using the DEM Extraction Wizard (see “Step 6: Generating Epipolar Images” on page 32) or by using the Topographic → DEM Extraction → Build Epipolar Images menu selection (see “Building Epipolar Images” on page 61).

Currently, the Epipolar 3D Cursor tool works with any stereo image pairs that have rational polynomial coefficient (RPC) data, either included in the original file or calculated by ENVI.

Opening the Epipolar 3D Cursor

To use this tool, you need an existing epipolar stereo pair.

1. From the ENVI main menu bar, select Topographic → DEM Extraction → Epipolar 3D Cursor. The Select Left Epipolar Image file selection dialog opens.

2. In the Select Left Epipolar Image dialog:
   - Select the left epipolar image from the Select Input Band list, or by opening an epipolar image file using the Open drop-down button and selecting the file.
   - Click OK. The Select Right Epipolar Image dialog opens.

3. In the Select Right Epipolar Image dialog:
   - Select the right epipolar image from the Select Input Band list, or by opening an epipolar image file using the Open drop-down button and selecting the file.
   - Click OK. The epipolar stereo image opens in a new display group, with the left epipolar image as the red band, and the right epipolar image as the blue band. The Epipolar 3D Cursor dialog opens (Figure 5-1).
Chapter 5: Epipolar 3D Cursor Tool

The cursor in the Image window is now a double red and blue cursor which, when viewed using anaglyph glasses, merges into a single cursor. You can control the 3D cursor using the specific mouse and keyboard controls shown in Table 5-1.

![Epipolar 3D Cursor Tool](image)

*Figure 5-1: Epipolar 3D Measurement Tool*

The cursor in the Image window is now a double red and blue cursor which, when viewed using anaglyph glasses, merges into a single cursor. You can control the 3D cursor using the specific mouse and keyboard controls shown in Table 5-1.

<table>
<thead>
<tr>
<th>Keyboard/Mouse</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse</td>
<td>Moves the 3D cursor around the epipolar stereo image.</td>
</tr>
<tr>
<td>Left Mouse Button</td>
<td>Causes the 3D cursor to snap to ground.</td>
</tr>
<tr>
<td>Middle Mouse Button</td>
<td>Exports the map and elevation for the point to an ENVI Point Collection table. See “Collecting Elevation Points” on page 53.</td>
</tr>
<tr>
<td>→</td>
<td>Moves the 3D cursor one pixel to the right.</td>
</tr>
<tr>
<td>←</td>
<td>Moves the 3D cursor one pixel to the left.</td>
</tr>
<tr>
<td>↑</td>
<td>Moves the 3D cursor one pixel toward the top of the image.</td>
</tr>
<tr>
<td>↓</td>
<td>Moves the 3D cursor one pixel toward the bottom of the image.</td>
</tr>
<tr>
<td>Num Keypad + (plus)</td>
<td>Raises the apparent elevation of the 3D cursor.</td>
</tr>
<tr>
<td>Keyboard Key = (equal)</td>
<td></td>
</tr>
<tr>
<td>Num Keypad – (minus)</td>
<td>Lowers the apparent elevation of the 3D cursor.</td>
</tr>
<tr>
<td>Keyboard Key - (hyphen)</td>
<td></td>
</tr>
</tbody>
</table>

*Table 5-1: Fine Tuning Controls*
4. Select which window to use for viewing the 3D cursor: **Image** (default), **Scroll, Zoom**, or **Off**.

5. Set the following **3D Cursor Parameters** according to your preferences.
   - **Size**: Size of the cursor. The default value is 2.
   - **Brightness**: Brightness of the cursor. The maximum value is 255, and the default value is 180.

6. Click **Snap to Ground Parameters** to open the Snap to Ground Parameters dialog.

7. In the Snap to Ground Parameters dialog, you can adjust the **Search Window Size** and **Moving Window Size**. See “Generating Tie Points Automatically” on page 23 for a description of these parameters. If the image is a high resolution image, increase the **Moving Window Size**.

8. If the topography appears to be inverted in the stereo anaglyph, use the **Swap Left/Right in Display** button to swap the red and blue channels in the display.
Collecting Elevation Points

Find a topographic feature whose elevation you want to know. When the cursor is located on the feature, click the left mouse button to perform a snap to ground. Snap to ground typically obtains better results when the current cursor is on a ground feature with distinctive spectral patterns. ENVI uses an image correlation method to find the conjugate point in the right image for the current left cursor location. When a snap to ground operation finds correct matches, the 3D cursor appears to snap to, or touch the ground point. Some fine tuning may be necessary to adjust the 3D cursor to obtain better results; the fine tuning keyboard and mouse controls are listed in Table 5-1.

If you are satisfied with the location of the cursor, click the middle mouse button to export the map and elevation information for that point to an ENVI Point Collection table. Each time you select a point and export the values using the mouse buttons, the point is added to the ENVI Point Collection Table. See “Collecting Elevation Points” on page 48 for more information.
Chapter 6

Individual Processes in DEM Extraction

This chapter covers the following topics:

Overview of Individual Processes ............... 56
Selecting Stereo GCPs ......................... 57
Selecting Stereo Tie Points ................. 58
Building Epipolar Images ....................... 61
Extracting a DEM .......................... 63
Overview of Individual Processes

This chapter describes the processes involved with DEM extraction, which you can run individually from the **Topographic → DEM Extraction** option of the ENVI main menu bar. Running these steps independently provides an alternative to using the DEM Extraction Wizard (for example, you may only be interested in building epipolar images without collecting GCPs). Although the underlying processes are the same between the individual menu options and the DEM Extraction Wizard, the dialogs and steps are slightly different.
Selecting Stereo GCPs

1. From the ENVI main menu bar, select Topographic → DEM Extraction → Select Stereo GCPs. The Select Left Stereo Pair Image dialog opens. See “Step 1: Selecting the Stereo Image Pair” on page 14 for instructions.

2. Select GCPs. See “Step 3: Viewing, Adding, Editing GCPs” on page 18 for a detailed description of the Stereo GCP Selection for DEM Extraction dialog, and how you can use it to select GCPs.

3. View the GCP list. Click Show Table in the Stereo GCP Selection for DEM Extraction dialog to open the Stereo GCP List table. See “Stereo GCP List Table” on page 21 for a detailed description of the Stereo GCP List table.
Selecting Stereo Tie Points

Collecting tie points is an essential step in the DEM extraction process. The DEM Extraction Module provides a standalone tool that enables you to collect stereo tie points and save the results to an ASCII file. The **Select Stereo Tie Points** menu item is accessed by selecting **Topographic → DEM Extraction → Select Stereo Tie Points** from the ENVI main menu bar. Use this menu option to perform tie point collection for a stereo pair of images by selecting tie points in one or both images.

1. From the ENVI main menu bar, select **Topographic → DEM Extraction → Select Stereo Tie Points**. The Select Left Stereo Pair Image dialog opens. See “Step 1: Selecting the Stereo Image Pair” on page 14 for instructions on opening the left and right image stereo pair.

2. When you click **OK** in the Select Right Stereo Pair Image dialog, the RPCs are computed and the left and right stereo images open in new display groups. The Stereo Pair Tie Points for DEM Extraction dialog opens.

3. Select tie points. See “Step 5: Viewing, Adding, Editing Tie Points” on page 26 for detailed information about this dialog and methods for generating, viewing, and editing tie points.

*Figure 6-1: Stereo Tie Points for DEM Extraction Dialog*
4. Click **Generate Tie Points Automatically**, to have the tie points chosen for you. The Generate Tie Points Automatically dialog opens. See “Generating Tie Points Automatically” on page 23 for details of the parameters.

![Generate Tie Points Automatically Dialog](image)

**Figure 6-2: Generate Tie Points Automatically Dialog**

5. Click **OK** to start the Automatic Tie Point Generation process. When the processing is done, the tie points are shown in the images, and the Stereo Pair Tie Points for DEM Extraction dialog looks similar to **Figure 6-3**.

![Stereo Pair Tie Points for DEM Extraction](image)

**Figure 6-3: Tie Point Data After Automatic Generation**
6. If the Maximum Y Parallax value is greater than 10, you must edit the tie points. See “Editing Tie Point Locations” on page 27 for detailed information about how to accomplish this.

7. In the Stereo Pair Tie Points for DEM Extraction dialog, click **OK** when you are finished editing the tie points. An ENVI query dialog opens asking if you want to save the stereo tie points to an ASCII file.
   - Click **Cancel** to return to the Stereo Pair Tie Points for DEM Extraction dialog.
   - Click **No** to exit the Stereo Pair Tie Points for DEM Extraction dialog without saving the selected tie points.
   - Click **Yes** to save the stereo tie points to an ASCII file. The Save Stereo Pair Tie Points to ASCII dialog opens.

8. In the Save Stereo Pair Tie Points to ASCII dialog, type the filename for the output file, or click **Choose** to navigate to the desired directory and filename.

9. Click **OK**. The Stereo Pair Tie Points for DEM Extraction dialog closes, as do the stereo image display groups.
Building Epipolar Images

The DEM Extraction Module provides a stand-alone tool that enables you to build epipolar images from a stereo pair. The **Build Epipolar Images** menu item is accessed by selecting **Topographic → DEM Extraction → Build Epipolar Images** from the ENVI main menu bar. Use this menu option to create epipolar image pairs that can be used for DEM extraction or viewed with ENVI’s Epipolar 3D Cursor Tool (see “Epipolar 3D Cursor Tool” on page 49 for details).

1. From the ENVI main menu bar, select **Topographic → DEM Extraction → Build Epipolar Images**. The Select Left Stereo Pair Image dialog opens. See “Step 1: Selecting the Stereo Image Pair” on page 14 for instructions on opening the left and right image stereo pair.
2. When you click **OK** in the Select Right Stereo Pair Image dialog, the Select Input Tie Points File dialog opens.
3. Navigate to the directory and filename where the tie point information is stored. (See “Selecting Stereo Tie Points” on page 58 for information about selecting tie points and saving them to a file.) Click **Open**. The Build Epipolar Images Parameters dialog opens.

4. The Build Epipolar Images Parameters dialog allows you to select an **Epipolar Reduction Factor** and whether to save the output images to a file or to memory. See “Step 6: Generating Epipolar Images” on page 32 for details of the parameters.
5. To view the epipolar results, select **Topographic → DEM Extraction → Epipolar 3D Cursor** from the ENVI main menu bar, or use the **RGB** setting in the Available Bands List and select the Left Epipolar Image for the red band, and the Right Epipolar Image for both the green and the blue bands. Load the RGB image to a display group.

Use anaglyph glasses to view the 3D image.

**Note**

The choice of the left and right image determines whether the epipolar image is a true epipolar stereo image or the inverse epipolar stereo image. If your scene appears to have surface features inverted, such as rivers appearing on top of mountains, not in valleys between mountains, you are seeing the Inverse Stereo image.

To correct this, re-display your epipolar images with the Right Epipolar Image in the red band and the Left Epipolar Image in the green and blue bands.

6. To interactively collect map and elevation data from your epipolar stereo image, use the Epipolar 3D Cursor Tool. (See “Epipolar 3D Cursor Tool” on page 49.)
Extracting a DEM

The Extract DEM menu option can be accessed from the ENVI main menu bar by selecting Topographic → DEM Extraction → Extract DEM. This menu option provides an alternate way to generate a DEM without using the DEM Extraction Wizard.

1. From the ENVI main menu bar, select Topographic → DEM Extraction → Build Epipolar Images. The Select Left Stereo Pair Image dialog opens. See “Step 1: Selecting the Stereo Image Pair” on page 14 for instructions on opening the left and right image stereo pair.

2. When you click OK in the Select Right Stereo Pair Image dialog, the Select Input Tie Points File dialog opens.

3. Navigate to the directory and filename where the tie point information is stored. (See “Selecting Stereo Tie Points” on page 58 for information about selecting tie points and saving them to a file.) Click Open. The Extract DEM Parameters dialog opens.

4. In the Extract DEM Parameters dialog, set the following parameters:
   - **Epipolar Reduction Factor**: This controls the down-sampling of the output epipolar image size. This factor is a floating-point value with a minimum of 1.00 (the default), which determines the lowest image pyramid level on which image matching can be performed. A value of 1.00 means the epipolar images have the same resolution as the input images. A value of 2.00 means the epipolar images have half the spatial resolution as the input images.
• **Extract DEM Parameters** and **Extract DEM Result**: See “Step 8: Selecting DEM Extraction Parameters” on page 36 for detailed information about these settings.

• **Stereo GCP File**: This allows you to load a pre-existing GCP file. Click **Select GCP File**. The Select Input GCP File dialog. Navigate to your GCP file and click **Open**.

• **Extract DEM Projection and Size**: See “Step 8: Selecting DEM Extraction Parameters” on page 36 for detailed information about these settings.

5. Click **OK** to proceed. The Epipolar images and parallax images are created, the DEM posts are built, and the DEM is geocoded before the DEM appears in the Available Bands List.

6. You can now view the DEM by loading it into a display group. You can also perform any editing on the DEM using the DEM Editing Tool (see “DEM Editing Tool” on page 41 for more information).
Index

Numerics
3D cursors, 50

A
across track stereo images, 7
along track stereo images, 7

B
background colors
DEM, 37

cursors
epipolar 3D, 50
extracting elevation data, 50

copyrights, 2

cursors
epipolar 3D, 50
extracting elevation data, 50

digital elevation data
collecting points, 48, 53
DEMs
extracting, 7, 63

ingredient images
creating, 32, 61
epipolar images, 32, 61
examing results, 39
GCPs, 16
output projections, 34
parameters, 36, 63
relative or absolute output, 8
requirements, 7
selecting stereo images, 14
tie points, 22, 58

E
epipolar images, 32
creating, 32, 61
reduction factor, 33
3D cursor tool, 50
ture vs. inverse stereo images, 33
viewing anaglyphs, 50

DEM Extraction User’s Guide 65
G

GCPs
DEM extraction editing, 18
selecting, 16
stereo GCP list table, 21

L

legalities, 2
likely error rankings, 30

S

snap to ground (Epipolar 3D Cursor Tool), 52
stereo GCP list table, 21
stereo images
3D measurements, 46

DEM extraction, 14
viewing anaglyphs, 50, 50

tie points
DEM extraction editing, 26
likely error rankings, 30
selecting, 22, 58
stereo tie points list table, 30
y parallax, 29
DEM Extraction Wizard, 22
trademarks, 2

y parallax, 29